
 

              

 

 

 

 

 

 

 

 

A guide to using iRecord 
 
 
 
 
 
 
 
 
 

Steve Garland – (v3.0) - May 2019 



 

 

 



 

3 

CONTENTS 

1. Why iRecord? 4 
2. Using Training Mode in iRecord 5 
3. Where does the record go? 7 
4. My Account 10 
5. General purpose data entry:  - Enter a casual record 12 
6. General purpose data entry:  - Enter a list of records 16 
7. General purpose data entry:  - Enter records at several places 17 
8. Data Entry Tips 20 
9. Uploading Photos 24 
10. Map Tips 25  
11. Exploring Records 27 
12. My Sites 32 
13. Taxon-specific Forms 36 
14. Summary Reports 37 
15. Searching Records Using Filters 40 
16. Searching Records Using Columns 42 
17. What Can Go Wrong? FAQs 44 
18. Top Tips & Some Fun Bits 48 
19. Activities 49 
20. Verification 55 
21. iRecord Mobile App 56 
22. Downloading Data & Reports 59 
23. Importing Data from a Spreadsheet 62 
24. Acknowledgements 73 

  



 

4  -  Steve Garland, iRecord Training – 2019 

CHAPTER ONE 

 WHY iRECORD? 

Wildlife recording can be a fascinating and rewarding activity. iRecord can not only make wildlife recording even 
more enjoyable but can also make your recording efforts become much more worthwhile.  Biological recording is 
not just about having fun, as good quality biological records are essential to inform everything from planning 
decisions to political policy to scientific research and practical wildlife conservation.  At its most fundamental level 
wildlife records are collected on paper or in digital form such as a spreadsheet.  It’s all too easy for the records to 
get forgotten about and left exactly where they are; the records are then not available for anything.  By using an 
online recording system like iRecord you can easily: 

• Share your sightings with the recording community 

• Explore dynamic maps and graphs of your data 

• Ensure that your records are available to appropriate organisations and therefore make a real contribution 
to science and conservation. 

Online wildlife recording presents lots of new opportunities: 

• Sharing records is simplified to the point that the recorder need not actually do anything other than add 
their records to the system. Records can be easily shared with other recorders, local record centres and the 
NBN Gateway.  Software and checklists are updated by the system, with no action required from the 
recorder. 

• By sharing our records, we can learn from the experiences of others such as what is being recorded on our 
patch by others, what identifications are being verified by experts and so forth. 

• By sharing our records, we can get rapid feedback from experts and other recorders on record quality issues. 

• By sharing our records, we can ensure our records are of maximum value and not just known only to 
ourselves. 

 

Tip: iRecord’s philosophy is that sharing of non-sensitive records is a fundamental part of wildlife recording. In fact, 
unless there are sensitivity issues relating to a record iRecord makes records available for public interest and to 
support nature conservation. iRecord is not the right tool for you if you want to keep a private list of records! 

 

There are a number of YouTube videos showing how to ‘do’ iRecord.  Go to YouTube and search for something like 
‘iRecord biological recording’.  A simple search on iRecord will unfortunately bring up lots of videos on a sound-
recording app with the same name!  However, remember that iRecord does get updated, so some may have dated! 
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CHAPTER TWO 

USING TRAINING MODE IN iRECORD 
 
Register on iRecord 

Before starting any work using iRecord, make sure that you have registered a user account and can log in. You can 
do this via the links from the iRecord home page. 

Whilst learning iRecord, you will want to go through the steps of actually submitting records into the system and 
seeing the results. If you are concerned about putting records into iRecord whilst you are still learning the basics 
then don’t worry as iRecord supports a training mode. Whilst in training mode: 

• the records you add are flagged as training records so they won’t be sent on to experts, local environmental 
record centres or the NBN Gateway. 

• training records are hidden from view for all users of iRecord unless they are also in training mode. 

 

 

To enable training mode, follow these steps: 

1. Click My Account from the link in the top right of the screen. 

2. Click on the Edit tab. 

3. Click on the Preferences tab. 

4. Scroll down to the ‘Who you are’ box and click on ‘What you record’ 

5. Tick the checkbox next to ‘Training’. 

6. Scroll to the bottom and click the ‘Save’ button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.brc.ac.uk/irecord
http://www.brc.ac.uk/irecord
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The following screenshot shows the My Account link, Edit tab, What you record tab and Training checkbox: 

 

Once you are in training mode, you will find that a message is displayed at the top of each page warning you. You 
can see from the following screenshot example that the records visible on the home page were those which were 
previously input whilst in training mode.  

 

Don’t forget to unset the training option when you want to start inputting live records! When you do 
this, your training records will remain in the system but will be hidden from your view until you choose to return to 
training mode. 
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CHAPTER THREE 

WHERE DOES THE RECORD GO? 

One of the big benefits of iRecord over written records and some other computerised recording systems is in 
relation to where your records go after you submit them. Many recorders are motivated to record wildlife because 
they want to ensure that records are available to decision makers, planning authorities, scientists, recording 
schemes and societies. Records on paper need considerable effort to get them into a form where they can be 
utilised. Even records in spreadsheets take considerable effort to import them into the databases used to collate 
records, since species names and other terms all need to be matched with the correct equivalents in the database. 
This might sound trivial but don’t forget that many species names are not unique; a redshank is a plant or a bird for 
example. A combination of the effort required to process records and the lack of awareness of the importance of 
collating records means that many records remain exactly where they started out - on paper or on a spreadsheet. 
This is even true of many records collected from that most modern of recording phenomena, the bioblitz; the 
effort required to mobilise the data is often considered not worth it. Of course that’s not to say that we shouldn’t 
hold events purely with the aim of public engagement, but with iRecord we hope to make mobilising records much 
easier so there are no good reasons not to. 

iRecord helps you to match species names correctly at the point of data entry by showing you the common name, 
latin name and species group when you pick a name, so issues with matching names are no longer a factor. The 
record is immediately in digital form with correctly input grid references picked from a map, no ambiguity in the 
way dates are written and so forth. Therefore fully utilising the records which are input into iRecord becomes 
much simpler. Creating an accurate record right from the outset is only part of the story, so lets take a look at what 
else happens next behind the scenes. 

The Database 

All records added to iRecord go straight into a database hosted by the Biological Records Centre known as the 
community warehouse. This name reflects the fact that the database is shared with a community of other online 
recording websites for reasons which we will come to later. The records are held securely and are regularly backed 
up. 

Records are immediately available 

All non-sensitive records added to iRecord are immediately available for browsing on the Explore pages of the 
website. Local environmental records centres have instant access to records, to ensure that they are not 
overlooked in the local planning process while they are waiting for verification. Of course, a record needs to be 
verified before it is used as evidence for decision making, but instant access to unverified records can help ensure 
that important species and habitats are not harmed due to lack of awareness of their presence. 

Automated checks 

Records added to the database are subjected to a number of automated checks. For example, if a record is outside 
the expected distribution of the species or at an unexpected time of year, then a flag is added to the record 
marking it as such. These flags shouldn’t be considered as an indication of a “bad” record though - a record which 
is outside the known distribution is exactly the sort of record which can show the movement of a population if 
enough evidence is available to verify the record. 

http://www.brc.ac.uk/
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The rules used for the automated checks are based on criteria originally developed by the national recording 
schemes for the NBN Record Cleaner software, which was designed to highlight records that fall outside normal 
patterns of distribution or time periods.  As new records are verified within iRecord, the system ‘learns’ so that if a 
new species gets verified several times from a new area, it no longer triggers an ‘out-of-range’ warning. 

Expert Verification 

The next, critical step in the journey of the record is a review by an expert. Only expert verified records can be 
used as evidence in planning enquiries, species atlases etc. That doesn’t mean a record that cannot be verified is 
not useful; even if it only gives guidance for further professional surveying - every record is valuable. 

Experts have access to a list of the records pending verification, which is filtered to their region and taxonomic 
speciality as appropriate. They also have tools to quickly verify records (for example you can verify en masse all 
records of common, easily identified bird species by trusted recorders).  Photos uploaded with records are often a 
great help in verifying records of some species groups but in many cases the expert needs to contact the recorder 
to check further details or to ask if a specimen is available.  iRecord’s verification system includes tools to make all 
these tasks as simple as possible for the expert so that they can concentrate on the important task of checking 
through the records. 

 

The above screenshot shows the verification system in iRecord. Notice how the verifier is able to verify records 
from multiple places from a single screen - in this case a page of Neuroptera awaiting verification by me. 

Chapter 20 has some further notes on Verification. 
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Records are passed to the NBN Atlas 

The NBN Atlas is the UK’s portal for exploring biodiversity data, a node of the Global Biodiversity Information 
Framework (GBIF).  Verified records from iRecord may be shared via the NBN Atlas.  The decision to do so lies with 
individual national recording schemes, although most do upload data.  From there, the records are made available 
to a number of other websites via NBN web services, and to an international audience via GBIF. 

 

Records added to iRecord will be made available to national recording schemes and their verifiers, and to local 
records centres, conservation organisations, natural history societies and others with legitimate interest in the 
data.  Wherever possible records will also be shared via the NBN Atlas, through the relevant national recording 
scheme. 



 

10  -  Steve Garland, iRecord Training – 2019 

CHAPTER FOUR 

MY ACCOUNT 
iRecord allows you to customise several aspects including the species groups you like to record most often and the 
region, county or area you most often record in. These are then used to customise reports and can also be used to 
simplify data entry or to bring to your attention any recording forms which might be of interest, so it’s worth 
spending a few moments familiarising yourself with the possibilities. 

To access your account, click on the My Account link in the top right of any page. 

The My Account section is divided into 2 tabs as follows: 

View Tab 

The View tab shows a summary of your settings, for example: 

 

Note on this tab the section called Recording Preferences which tells you what you’re mostly interested in. There’s 
more about this in later chapters.  

Edit Tab 

The Edit tab allows you to change your Log In password and to set your account to allow vague dates (such as ‘July 
2019’ or ‘04/08/2018-10/18/2018’, which are not allowed by default. 
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You can also set the frequency that you receive emails with your notifications.  Notifications are mentioned under 
Verification. 

The Edit Tab is divided into 4 further sub-tabs. The first one is ‘Who you are’ which just allows you to change your 
name.  The important one is called ‘What you record’:  

 

On the ‘What you record’ tab you can set the species groups you are most interested in.  Tick all those you 
regularly record.  You can change these at any time later. 

The third one is ‘Where you record’ where you can select a Vice County where you usually record. When you open 
iRecord you will find that the map is centred on this area.   

Note that the list of locations available to pick from uses the list of Watsonian Vice Counties  
(https://www.brc.ac.uk/article/british-vice-counties). These are often used in biological recording since they are 
persistent and not subject to the changes that our list of administrative areas are subject to. 

When you have set the options remember to click the Save button at the bottom of the page.  
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CHAPTER FIVE 

GENERAL PURPOSE DATA ENTRY FORMS - 1 

Enter a casual record 
To add a record: 

1. First make sure you are logged in and NOT in Training Mode if you wish to save real records. (Note: you 
can use these forms in Training Mode to try them out, but records will not be made available outside 
training mode. 

2. Select Record > Enter a casual record from the main menu. This takes you to the form for general ad-hoc 
records. There are other forms for lists of records as well as forms catering for specific surveys, species 
groups and places which we will learn about later. The top half of this form allows you to set most details of 
the record other than the locality information. 

The screen displays a number of boxes for data.  Five of these have a red asterisk (*) next to them.  These 
MUST be filled in or you won’t be allowed to save the record.  All of the rest are optional, although the more 
you can complete, the greater the value of your record. 

 

3. Record destination – The default is ‘Ad-hoc non-group records.  If you create or join Activities (see later 
section) they will appear here as drop-down choices. 

4. Date. Click in the box beside the Date label and you will see that a calendar panel pops down making it really 
easy to simply click on the correct date. If you need previous months or years then you can use the controls 
at the top of the panel to change the visible month. Obviously future dates are not allowed.  You can also 
type in a date directly in the format dd/mm/yyyy – often the easiest way when entering records from 
previous years, or old collections/notebooks. 
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So, click on today’s date to set the date for the record. 

5. Recorder name. The Recorder Name field will already have been filled in with your name as a default value.  
If you are entering a record made by someone else, you must add their name here, in the format Surname, 
Forename. 

6. Species.  Click in the box next to the Species label. Start typing the first few characters of a species name, 
e.g. “blueb” to search for Bluebell, Hyacinthoides non-scripta. The list of possible matched species names 
appears below the input box: 

 

 

If the species you are looking for has come to the top of the box then simply press return, or click on with 
mouse, to select it, or you can use the arrow keys to navigate in the list then press return when the species 
you want is highlighted.  If the list is a long one then and your name hasn’t appeared, scroll to the bottom 
and it may say More available… so click on this to see more choices.  More ways of entering this are in 
Chapter 8. 

7. Certainty.  Although most records are put on iRecord with a relatively high degree of confidence in the 
identifications, there are many reasons why iRecord should accept less than certain records.  These can be 
Certain, Likely or Uncertain. 

a Uncertain records can still act as a pointer to others who may want to confirm the record 
themselves. 

b An uncertain record as determined by the recorder might be accompanied by enough 
information for the record to be verified by an expert. 

c Most recorders like to keep all their records for the sake of completeness, not to have to discard 
the ones that they cannot be 100% certain of. This is especially important to the newcomer recorder 
who might one day be the expert verifying my records. 



 

14  -  Steve Garland, iRecord Training – 2019 

Therefore, always set the certainty of your record’s identification as it ensures that the record is not 
misinterpreted or misused. It may also flag up a record for closer attention from a Verifier 

8. Quantity. This category is free text.  Examples include: 1, 2-5, abundant, several, large flock, one clump… 

9. Sex.  Drop-down – male, female, mixed.   

10. Stage. Drop-down.  On this simple form the choices are restricted to: adult, pre-adult or not recorded.  For 
animals (including insects) it is very helpful to say if you are recording an adult or not, but for plants the ‘not 
recorded’ option is the only relevant one.  Again, this is a general-purpose form and this field may not be 
appropriate to all records, but where possible set the stage of the organism if you can. 

Note that iRecord does support more specialist recording forms, e.g. the British Dragonfly Society’s survey 
recording form, where the list of options is more specific including Adult, Copulating, Ovipositing, Larva, 
Exuvia etc. 

 

11. Identified By. -Knowledge of who identified a record is a really important piece of information when 
verifying records.  If someone else identified your record for you, this is where you put their name. 

12. Add photo – See Chapter 9 

13. Is the record sensitive – All records are available to all users of iRecord.  There is a tiny risk that some 
people with harmful motives may access data and misuse it.  Some records, for example badger setts or 
rare bird nest-sites may be best kept from public access.  To this end iRecord lets you BLUR your data for 
the public.  However, data blurred in this way causes problems with mapping and data extraction, so is best 
avoided.  For example, the record will appear in reports for any site the 10km or 100km square overlaps 
with.  If your data is really that sensitive, iRecord is probably not the best place to put the record.  If you do 
use this blur option, try to keep it at as detailed a level as possible to avoid causing problems. 

14. Location.  Type in the site name where you recorded the species, or a brief description of the site.  If you 
have created sites or added NNRs as My Sites, as you start to type their name, they will appear in a drop-
down box.  If your site is not in My Sites, after you enter or select a Spatial reference a button to the right 
of the Location will offer the option to Remember site.  If you click this the site and grid reference will be 
saved and will appear in future as you start to type the name.  This can be helpful if you decide to add it to 
My Sites later. 

15. Spatial reference. – This is detailed information on the place. You can enter a grid reference, latitude and 
longitude, Irish Grid Reference or Channel Islands Grid Reference. The quickest way to do this is usually to 
scroll down the page till you can see the map, then move the mouse over the map to the general area of 
the record. As you hover over the map, you can see a dotted outline of the grid square which you are 
currently over informing you where the grid square will be set when you click.  If you are using a saved Site, 
the site will already appear in your map window, making things even easier.   
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Double-click or use Ctrl + mouse-wheel and the map will zoom in so that you can click again to set a more 
precise grid reference.  Do this until your grid reference is placed to an appropriate level of precision.  A 
10m grid square is a good aim if you can be that accurate! 

You can also type in the grid reference or Lat/Long directly. 

 

16. Habitat – This is a hierarchical drop-down list of habitats.  However, it is quite basic and, in many cases, I 
find that it does not provide a useful or relevant category for my recording.  You can always add something 
descriptive to the Comment box.   

NOTE/WARNING – The habitat box can be quite annoying when you are using sites you have created.  
iRecord will remember the habitat that you chose when you entered the last record for the site.  This is 
something you can miss if you haven’t any habitat data for a subsequent record.   I know I miss it 
sometimes because I don’t often enter anything here so I can end up with ‘bogs and fens’ on a limestone 
hill if a big site has varied habitats! 

17. Comment – A free-text box to add anything that may add value to the record.  Another important use is to 
add information that may help the expert Verifier to ascertain the accuracy of your identification by 
explaining HOW you identified it.  For example, it might say a specimen was observed microscopically, was 
dissected or that a voucher has been kept if needed.  You can also mention the identification key or book 
used, which may help considerably.   

18. Finally, click the Submit button to save your record. 

 

Important Note – Don’t hit the enter key until you are sure you have finished as that will 
SUBMIT the record. 
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CHAPTER SIX 

GENERAL PURPOSE DATA ENTRY FORMS - 2 

Enter a list of records 
This form is designed for quickly entering a list of records that were collected at the same place, on the same date, 
by the same person. Each record added on the Enter a List of Records data entry form has exactly the same 
information as the Enter a Casual Record form. The big difference is that you only input information about the visit 
once and you use a grid to enter a list of all the records that share the same visit information. Another difference is 
that the form is divided onto 2 tabs, with information about the place you visited on the second Where Was It? 
tab. 

Entering the date, recorder name and visited place information is exactly like entering these details on the Enter a 
Casual Record form. However, the species input grid is different: 
 

 

Inputting records is simply a matter of typing species names into the first, Species column. This matches the text 
you input against the list of known species names, exactly as when you are inputting a single record. Once you 
have input a species name, a new row is added to the bottom of the grid letting you continue adding more species 
records. When you add a row to the grid for a species record, you can also set the following attributes of the 
record: • Certainty 

• Quantity 
• Sex 
• Stage 
• Identified By 
• Comment – There is still an Overall comment box at the end – for example if all records were from an MV 

trap it could go there.  The comment box next to each record allows for specific comments on habitat, 
Identification process etc relating only to that one record. 

• Images (Photos) See Chapter 9 
 
The locality data is on a separate tab/page ‘Where was it?’.  Once you click on this tab, you can’t return to 
your species list until you have put data in all the essential (red *) fields. 
 
USEFUL NOTE – If you want to add more records from this sample later, find one of the records and click the 
Edit icon.  Then below the record you will see ‘View all the records in this sample or add more records’ – click 
this and you can then add more without having to add dates, site data or other shared information. 
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CHAPTER SEVEN 

GENERAL PURPOSE DATA ENTRY FORMS - 3 

Enter records at several places 

Although entering a list of records from one place on one day can be a quick way of inputting lists of records, most 
recording trips involve records from more than one grid square. The Enter Records at Several Places form is 
designed to handle this quickly and efficiently - you can add a number of grid squares to a map and enter any 
number of records you like at each grid square. 

Select Record > Enter records at several places from the menu. This form allows you to easily add records for 
multiple grid squares. Find the right place on the map, by selecting Google satellite using the layer picker on the 
map (the blue cross button near the top right of the map).  

 
 
Use the zoom bar on the left of the map to zoom out or in and you can drag the map around using the mouse.  
You can use the pan and zoom controls on the map to zoom in.  
Select a grid square to input records; the map will slide out of view to be replaced by a grid allowing input of the 
records at this grid reference. 
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Tip: If you record regularly at a site, it really will be worth creating a site in the My Sites feature to make finding 
repeat sites very easy! 
The entry grid looks as below… 

 

We can of course specify additional details for any of these records if required. Click the Finish button to the top 
right of the grid when you are ready to continue to add the next grid square. 

Click the Finish button when you are done. The map below shows an example at this stage. 

 

 

You can continue to add more records at further grid squares and can add extra records to one of the existing grid 
squares. Click the Modify Records button above the map. Note how the instructions just beneath the buttons 
changes to tell you what to do: 

Select the records on the map you wish to change. 

Click on an existing grid square and you will return to the grid view of the records where you are free to add new 
records, details of records or to remove records you no longer want to add.  

Move records - If you wish to move the location of records, click on the Move Records button and the instructions 
now say: 
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Please select the records on the map you wish to move. 

Click on your chosen grid square and the instructions change to: 

Please click on the map to choose the new position. Press the Cancel button to choose another set of records to 
move instead. 

You can zoom the map in (the “ghost” image under the mouse cursor shows you how precise the grid square will 
be when you click). Click on the map just to relocate the square.  

 

Modify records – If you have made a mistake, or wish to add something further, click Modify Records and the 
original record entry table will appear.  You can then add more or edit existing records. 

Delete records – clicking on this will let you select a square to delete.  It will ask for confirmation before you take 
this drastic action! 
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CHAPTER EIGHT 

DATA ENTRY TIPS 
Data entry in iRecord is designed to be as quick and intuitive as possible, but there are a few tips and tricks which 
can make things even easier.  

Control locking 
There are little padlocks next to many boxes.  If you click on one, they lock as below. 
 

 

Try it with the lock by the Date, the date control is now greyed out and the padlock locked, indicating that the 
control value cannot be changed. Try clicking on the date control and you will see that it no longer accepts input. 
The real value of control locking is the control’s value will be remembered the next time you use this form. So, we 
can use this facility when we need to input several batches of records which share some of the same attributes 
such as the date, place or recorder. 

This works in the same way for all fields with padlocks. 

Inputting lists of species 
Choose Record > Enter a list of records (for a site on a date). 

 

Tip: Don’t forget that you can use the tab key to navigate forwards in the form - this is a standard feature of web 
browsers. Shift tab allows you to navigate backwards. 

 

Here are a few names of species that can be entered: 

• Lords and ladies 

• Dog violet 

• Greater-Spotted Woodpecker 

• Parus caeruleus 

• Magpie 

It is worth exploring a few of the different issues relating to finding species names to get a clearer understanding of 
how it works so you’ll be able to find names quickly and efficiently. Type “lords and” into the species name box. 
Your search is sent to the server and used to lookup possible species name matches as follows: 
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This is an interesting (i.e. deliberately chosen) example. 3 results are shown, but they are all for Arum maculatum, 
i.e. Lords-and-ladies or cuckoo pint. The reason is that iRecord uses the UK Species Index to provide species names 
and the UKSI lists 3 variants of the common name Lords-and-ladies with different capitalisation. Another 
interesting point here is that there are hyphens in the common names listed and the names are found even if you 
didn’t include the hyphen in the characters we typed. 

 

Tip: iRecord doesn’t care about punctuation and other special characters when you search for a species name, so 
don’t bother typing them. In fact, spaces are also ignored - typing “7sp” is enough to find “7-spot ladybird” and 
would also find 7 spot ladybird if it were listed without the hyphen. 

 

Another way to select a species name uses an abbreviation of the scientific name - Type “armac” which is 2 letters 
from the genus name and 3 letters from the species name.  This should find the species for us as iRecord supports 
2+3 letter abbreviations as used in some other recording systems.  However, as there are quite a few species with 
the same abbreviation, Arum maculatum does not make it to the top. One way around this is to limit the search to 
flowering plants, which is particularly useful if entering a list of many flowering plant records. 

 

Tip: When using 2 + 3 letter species name abbreviations, utilise the filter button in the Species column header to 
limit your search to the appropriate species group(s). This works even more effectively when entering species from 
a not-so-extensive group as flowering plants. 

 

To change the species names filter, click the filter button in the column header of the Species column. This pops up 
a dialog box allowing you to configure what names are available in the search filter. Select the option Input species 
from the following species group then in the associated drop-down box choose flowering plant. 
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Click Apply. Now, clear the species name input box and type “armac” again. This time you will find that Arum 
maculatum appears in the list a couple of places from the top. Use the down arrow key to move the highlighted 
name down, then hit the return key to select it. 

The species name is selected and a new row is automatically added to the grid. Note that the input cursor is put 
straight into the new box in the Species column ready for you to continue typing species names. Let’s try the next 
name in the list, written as “Dog violet”. Type this name in. Nothing is found - you can tell this because the rotating 
“searching icon” appears briefly and then disappears, indicating nothing was found. One thing to bear in mind 
about using the UK Species Index to lookup species names is it does not understand the vagaries of the ways that 
we often share names. There are actually many dog violet species; we happen to know that Fred meant common 
dog violet, because we know Fred would have specified if it were something different. But iRecord can’t make 
these assumptions for you. If you can’t find a species name because you know that there is a part of the name 
missing, then insert a * character (asterisk character) as appropriate to act as a wildcard. Insert a * at the start of 
the species name input so you are searching for * dog violet and you will find that a number of dog violet species 
are returned with common a little way down the list. Select it and we’ll move on. 

Now that you have input the plants from the list, click the filter button again and this time set the filter to “Birds” 
and click Apply. 

iRecord does not care about capitalisation, spaces, or punctuation, type “greaterspottedwood” into the next 
Species search box.  Again, the name is not found (this has been deliberately chosen to illustrate problems to learn 
how to handle them!). You might have noticed that we are searching for “Greater” instead of “Great”, but 
assuming that we hadn’t spotted this problem in the name we’ve input, a good way forward would be to search 
for something like “great*woodpecker”, since at least these parts of the name are unambiguous. 

 

Tip: The * character is your friend when struggling to find a species name. 
 

The next species for input has the latin name Parus caeruleus. Input this name and the name will not be found. 
This is because P. caeruleus is the name used for Blue Tit until a few years ago, when taxonomists realised it was 
not actually in the same genus as Parus major, the Great Tit.  So, now it is known by the new name Cyanistes 
caeruleus, though the previously used synonym is sometimes still in use. We don’t want to look up the correct 
name to use every time this happens, so another option is to enable searching for synonyms. To do this, click the 
filter button in the Species column header again. This time, change the drop-down option for Choose species 
names available for selection to All names including common names and synonyms. In other words, all the names 
available in the UK Species Index become available for searching, whether they are current or not. Now retype 
“Parus caeruleus” and you should find that this time, the name is found. 

As one more illustration of grid-based name input, try inputting a few dragonfly and damselfly names to examine 
the most efficient key strokes. The list we will input is: 

• Beautiful agrion - Calopteryx virgo 

• Common Darter - Sympetrum striolatum 

• White-Legged Damselfly - Platycnemis pennipes 

Clear the species names you have input so far, and try the following key strokes as quickly as you can: 

cavir<return>systr<return>plpen<return> 

Now, try the same experiment again, but type the following set of characters. Note the missing p in “plpen” which 
is our pretend typo. 

cavir<return>systr<return>plen<return> 
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This time, if you managed to press return before the search completed for the misspelt “plen”, then you will notice 
the species name input box informs you that it failed to find any matches. Time to go back and correct it! 

 

Tip: Practice using the keyboard only to input species and associated attributes into the input grid. In time it will 
become intuitive and is faster than using the mouse.  Do this in Training Mode if you feel more comfortable. 

 

One more thing, try typing “cavir” into the species search box then pressing <tab> instead of <return>. This time, 
the species name is picked but the input focus moves to the next control in the same row. You can then use the up 
or down arrow and return key to change the certainty of the record, or press tab again to change one of the other 
column values. Press tab a few times to move to the next row when ready to add a new species name, or shift tab 
to move backwards. When you are in a text input box (such as Quantity, Identified By or Comment you can use the 
up and down arrows to navigate between rows, though the web browser reserves these keystrokes for selecting 
items when the focused control is a drop down. 

 

Tip: Don’t forget to use the record certainty attribute to mark-up records which you are not certain of the 
identification for. Also, note that if you are not certain of an identification to species level, but are certain of the 
genus you can always add a record at genus level. 
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CHAPTER NINE 

UPLOADING PHOTOS 
The ability to attach up to 4 photos to each record added via the grid is accessed via the add images link in the 
rightmost column of the grid.  It’s simply a matter of picking an image file from your disk to upload. 

The file upload system used by iRecord examines the capabilities of your web browser to determine the best way 
to upload files. For example, if you are using a modern web browser with support for the latest standards, then it 
can resize the image so that the upload time is fast and show a progress bar for the upload. If you are running an 
old browser which does not support the latest web standards, then it will do a standard file upload which will be 
slow. If you are uploading multiple images for a batch of records, then a slow upload speed could become 
completely unworkable quite quickly. High speed broadband should provide quick uploads in most cases. 
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CHAPTER TEN 

MAP TIPS 
Here are a collection of tips and tricks for using iRecord’s map during data input.  

Map Layers 

Click on the blue + button in the top right of the map. This expands a panel allowing you to choose from the 
various layers available. On the following screenshot, the first 2 are background layers provided by Google and the 
third is an Ordnance Survey map - you can show only one of these at a time. The second 2 are overlays which are 
drawn over the top of the base layer. You can show any combination of these you like.  Because this user has 
identified themselves as working primarily in West Lancashire, the boundary of this Vice County has been added as 
default, but can be unticked if preferred. 

 

Try changing the settings to see what they do. When you’ve finished, click the - button in the panel to close it. 
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Navigating around the map 

Also overlaid onto iRecord maps you will find navigation and zoom buttons on the left hand side. Although 
sometimes a handy way is to use the mouse left button to drag the map around as required and to double click on 
the map to zoom in.  

Another way to zoom into a precise region is to hold the shift key, then mouse-drag a rectangle on the map. The 
map will then zoom to show the rectangle.  You can also zoom using Ctrl - mouse-wheel. 
 
A third way to zoom the map into a place is to use the search for a place on the map input box on the left to find a 
town or village by name. Try typing “alfriston” into the box then click Search and the map will zoom into the village 
of Alfriston in Sussex, as it managed to find a unique place with that name. If you try searching for a more 
ambiguous name such as “arlington” you will see that you are given a list of possible matching places to pick from.   
However, it doesn’t always find the place you want and you still have to click the map to select a grid reference for 
it. 
 

 

7.4.3 Setting a grid reference for your record 

The simplest way to set a grid reference for your record is to click once on the map where you would like the 
record to be. Most of the time this is all there is you need to know. The following points give you some extra 
details though: 

1. As you hover over the map, a “ghost” image of the grid square you are about to pick is shown. This gives you 
a preview of the square size and position. 

2. The more you zoom the map in, the more precise the grid reference will be. The map won’t set a grid 
reference that is more accurate than could realistically be expected from the scale of the map. 

3. When you click to set a grid reference, the map will zoom into the grid reference square giving you a chance 
to click again to set an even more precise grid reference. 

4. If the map is showing the street map base layer, then when you click on the map to set a grid reference and 
it automatically zooms in, if the zoom scale is high enough the map will automatically switch to satellite view 
so you can set a precise grid reference more easily. 

5. If you hold down the + key whilst over the map, the precision of the grid reference is increased.  Using the 
minus key will return you to six-figure precision. 
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CHAPTER ELEVEN 

EXPLORING RECORDS 
One of the key features of iRecord is that non-sensitive records are immediately visible to other users. This allows 
you to see what is being recorded near your patch or by your friends and colleagues. In this section we will take a 
look at the Explore options available in iRecord for browsing existing records. 
 

Exploring my Records 

There are 2 Explore pages accessible from the menus in iRecord - Explore all records and Explore my records. Both 
are the same except that the My records version is filtered to only your own records. 

The Explore pages are divided into 2 parts, a map panel and a data panel as described below.  If you have added a 
recording area to your profile, it will appear and your map will be centred on it. 

Map Panel 

The map shows records that match the current filter; in this case the filter is all records input by me. When you are 
zoomed to show a distant view of the map, a small grid square would simply not be visible so iRecord 
automatically draws a larger circle over the record until you are zoomed in far enough to show the record as a 
proper square. This map image shows the appearance of records when you are zoomed out: 

 

NOTE - Selecting specific records - You can click on the question-mark icon (map, top left corner) then click 
on a square and the list of records will be filtered to include only those from that square. 
 
If you hold the left mouse button down and drag the mouse you can draw a rectangle and then see all records 
falling within that area. 
 
The third symbol in the top right will make your map full-screen, which can help by giving you a larger working 
area. 
 
And on the next page are the same records, shown when zoomed in: 
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The larger squares are records with 1km data, the smaller squares are 100m squares, circles are records from the 
iRecord App that were originally input as Lat/Long.  If you zoom in further you would see tiny 10m squares too 
where data had that level of accuracy. 

Data Panel 
Underneath the map there is a data panel which shows a list of records currently loaded on the map: 

 

In this grid, details of the record including any photos are shown. The icon in the ID column gives an indication of 
the record’s quality: 

• No symbol – not yet checked by an expert 
• Red cross - record checked by an expert and not accepted as was unable to verify 
• Two red crosses – not accepted as is incorrect 
• Question mark - record checked by an expert and marked as plausible 
• Green tick - record checked by an expert and considered correct 
• Double green tick – record checked by an expert as correct 
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Verifiers use these statuses in slightly different ways, but generally:  

• Correct – often a picture was attached that allowed the verifier to confirm an accurate ID, or it may be 
that the ID is straightforward and the Verifier knows the recorder is competent.  However, some Verifiers 
use this only for records with proof attached.  This record will go into the NBN database. 

• Considered correct – This may include critical species where the recorder is known to be competent with 
the species, but actual proof wasn’t attached (I don’t post a picture of the genitalia of every critical moth 
species I dissect.  If they are common and easy to ID on genitalia I will have posted at least one picture to 
show my ID, but the Verifier may trust me after that).  Recording schemes often have critical species, 
where they will only accept records with proof.   This record will go into the NBN database. 

• Plausible – Verifiers may use this for common species that are known in the area, but the level of skill of 
the recorder, or the amount of information provided doesn’t provide adequate proof for confirmation. 

• One cross would include photographs where not enough detail is visible for a positive ID, but it could be 
that species. 

• Two crosses mean that the Verifier considers the record to be DEFINITELY incorrect. 

The data panel has four other tabs, showing a list of the species currently loaded; a list of Taxon Groups; a list of 
Families and all associated photos. All of these lists can be filtered to find the information that you need (see 
Chapters 15 and 16 for more information on filtering): 
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Explore > My photo gallery 

Your photos can also be viewed from the Explore > My photo gallery menu item provides exactly that: 

 

There are simple filters based on date range and species group to help you look up photos. For more advanced 
filtering options, your photos are presented in tabular form on the other explore pages. 
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Explore > Species Maps 

The Explore > Species Maps page provides a really quick and easy way to draw maps of the various species data 
held in iRecord.   

REMEMBER – this isn’t a full national distribution map, just those on iRecord, minus any filtered out by you. 

 

Simply search for the species you want to map in the table on the left and use the + button to add a map layer for 
that species. You can: 

• Add up to 4 species layers to the map at once 

• Filter to show only your own records 

• Use the filter row in the top of the species table to search for a species by name. 
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CHAPTER TWELVE 

MY SITES 
The My Sites facility in iRecord is a great way to keep a personal list of sites you regularly record at.  You can 
also add sites selected from a standard list of sites to your own personal list, currently the only sites available 
are the National Nature Reserves but other site types may be added in future. 

Follow through the steps below to add one of your local recording patches to your account. 

1. Select Explore > My Sites from the menu. Click the Create Site button near the bottom of the page to 
start adding a new site on the Site Details page. 

2. Enter a name for your site into the Site Name box. 

3. Use the Search for Place on Map box to search for a nearby town or village. Once you have zoomed the 
map to the vicinity of your site, use the methods of panning and zooming your map until the map 
includes all of your site boundary. 

4. Select the leftmost tool in the row of toolbuttons at the top of the map. This tool lets you specify the 
centre grid reference of your site. Click once on your site’s approximate centre to set this. 

 

Symbol 1 - click on the map to set a location which is then used as the default grid reference for the 
site. 

Symbol 2 – Make the map full screen 

Symbol 3 – Draw a polygon to create a site.  

Symbol 4 – Draw a line to create a linear site 

Symbol 5 – Modify an existing outline.  You need to play with this one as it can do lots of different 
things 

Symbol 6 – Use this to drag the map around 

NOTE – If you are in the middle of drawing a map and you are running off the edge, you can click, hold 
down the button and drag the map.  When you release the button, you will not have added to your 
boundary and can then continue.  (Sometimes you may find that a new point hasn’t been added to your 
boundary when you expect it – this is caused by you slightly moving the mouse by accident.  Don’t worry, 
click again). 

5. Specify a comment for your site to describe it (Optional). 

6. Using the map layer panel, switch to Google Satellite as your base layer. 

7. Since our site is a polygon (it could be a linear site), choose the next tool to the right which is the draw 
polygon tool. 

8. Now, click once on the map on a corner of your site. Work your way around the site boundary, clicking 
once for each change in direction of the site boundary to gradually build up the shape of your site. 
Double click to finish once you have completed the boundary. 

My site details form now looks like the following: 
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Press the Submit button to complete the site creation process.  You can now enter records for the site. 

1. Select Record > Enter a casual record on the menu. 

2. Set a record for today’s date and choose any species you would like to record. 

3. In the Location box, type the first few characters of the name of the site you just created. iRecord will 
search against your list of sites and find the matches. When the site name appears, select it. iRecord will 
zoom the map straight in to show the site boundary for you. 

4. Click once on the map to set the grid reference, zooming in further first if necessary. 

5. Set the Habitat as appropriate for your record. Note that this value will be remembered for you the 
next time you record at this site. 

6. Save the record. 

7. Go back to the Explore > My Sites page. This time, click the Explore button beside your site. This takes 
you to the Explore my records page, filtered to show your records from that site. Below is an example 
using Heysham LWT Nature Reserve 

USEFUL NOTE – If you make errors in your boundary you can either: 

• Use the Modify button to modify it OR 
• Just repeat the drawing process again.  At the finish it will ask you whether or not you want to replace 

the previous boundary – click yes and the old one will disappear – the new one will replace it. 



 

 34  -  Steve Garland, iRecord Training – 2019 

 

 

 

 

 

The next page shows what the My sites page looks like once you have created a number of sites.  Each site 
shows the number of your records, number of species (taxa) and number of taxon groups from that site.  By 
clicking on the column headers, you can sort them in ascending or descending order either numerically or 
alphabetically.  This screen-shot has been sorted to show the sites with the most records first. 

Note also that you can have overlapping sites. 

If you wish to find a site by its name you can sort the columns and use searches including wildcard searches as 
described in Chapter 15 and 16. 
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CHAPTER THIRTEEN 

TAXON-SPECIFIC FORMS LIBRARY 
Previous chapters have shown the general-purpose recording forms.  These are quite basic in terms of the 
attributes that you can record with each record, for example you can’t provide detailed life stage information 
in the Stage field since the field’s values are general purpose.  As well as more specialist recording forms, 
iRecord also allows groups, schemes and societies to add forms for their own purposes, with attributes and 
options appropriate to them.  These are available on the Record > Taxon-specific Forms menu item.  As of 
January 2019, they include: Vascular plants (grid recording); Bryophytes; Dragonflies – multiple species; 
Dragonflies – single species; Ladybirds; Moths and Glow-worms.  More may be added as new groups create 
special forms. 

Because of the way that iRecord was developed, adding new custom forms such as these is a fairly simple 
process, so the library of available forms is likely to continue growing. 
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CHAPTER FOURTEEN 

SUMMARY REPORTS 
The Summarise Menu option provides access to some quick and simple ways to view data summaries from 
iRecord. 

My data summary 

Click on the Summarise > General Summaries menu item to access a collection of reports summarising the 
records you have entered as well as the records entered into iRecord as a whole. 

 

My dashboard 

Summarise > My dashboard shows a graphical summary of your data input over the last year and progress on 
verifying your records.  The Verification progress by week shows exactly that. 

 

 



 

 38  -  Steve Garland, iRecord Training – 2019 
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Survey Summaries (Activities – see chapter 19, p49 for more Activity info) 

Specific surveys which host their records on iRecord sometimes opt to provide a summary page to show 
progress. This might apply to a bioblitz or a survey of a specific site, for example. These summary pages are 
listed under the Summarise > Survey summaries menu item. Here’s the summary page available for Garden 
Bioblitz to 2018 
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CHAPTER FIFTEEN 

SEARCHING RECORDS USING FILTERS 
There are two levels for doing this – either ‘Explore my records’ OR ‘Explore all records’.  The main difference 
between the two is that the default start screen for ‘my records’ will include all of your records, whereas the 
default start screen for ‘all records’ will include just the latest month of everyone’s records.  This is because 
starting the screen with absolutely all records on the database would be extremely slow, due to the numbers.  
If you are searching ‘all records’ you will almost always want to select a filter to run or create a filter, which will 
include the date period you are interested in – unless you really are only interested in the last month! 

If you are searching ‘my records’ you may also use these filters as well as using ‘Table Column filters’ – see the 
next Chapter. 

Go to the Explore > Explore all records screen.  The map shows dots for all records received in the last month 
only.  They are also listed in a table underneath.  In one month, this can still be 20,000 or more records.  This is 
because the system would run too slowly if it tried to load all the records - at the foot of the Home page there 
is the latest total of records in the iRecord system – 6.6 million on 28 January 2019. 

If you want to extract records for (say) a particular Vice County, site, or for a particular taxa or map reference 
you will need to use a filter.  You can create one to suit your needs and then save it for future use. 

Click on Create a filter on the top right of the bar above the map and the following choices will appear. 

 

 

What lets you choose taxa to include.  This can be done at species, Family or Order levels or using conservation 
statuses, marine or non-marine statuses (useful for Isopods if you only want woodlice or for freshwater fish for 
example) and for Levels (though I’ve never found a need for this yet!). 

Where lets you define a geographic area.  This can be one of your ‘My sites’ or Vice Counties, LRC areas etc.  
Whatever you select – remember to click the ADD button and your selection will appear beside a red X.  
Clicking this X will remove it again. If it isn’t there with a red X, you haven’t selected it.  You can also use grid 
references and even draw a shape on the map to filter records.  These are things you need to play with to see 
which are best for your needs. 

When is set as default at one month.  You can filter by the field record date, input date, last changed date or 
verification status change date.  Think about these to decide which one will give you the records you need.  
You can set dates FROM and TO, or a maximum record age such as 7 days, 1 year, 5 years, 8 months etc.  Click 
APPLY when you’ve finished. 
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Who only lets you choose to tick ‘Only include my records’ 

 

There is no way to filter out the records of any one recorder or group of recorders from the Filter menu. 

Record ID lets you select records by their unique number – this isn’t a feature I use much, but it’s there if you 
need it. 

Quality lets you included or exclude records based on whether or not they have been verified, whether they 
have been accepted, rejected, not yet reviewed and all other statuses and combinations.   

 

Source lets you filter records by their origins, with lists of possible sources under Websites, Survey datasets or 
Input forms. 

If you create Filters from the ‘my records’ screen you get all the above choices, except the Who category. 
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CHAPTER SIXTEEN 

SEARCHING RECORDS USING COLUMNS 
In both the ‘all records’ and ‘my records’ screens the table of records has headers – these being: 

• ID – the unique record ID code (a long number) 
• Source – how the data was input (includes ‘iRecord | App’;  ‘iRecord | Orthoptera Recording’; iRecord 

| general data and many others 
• Species – the scientific (latin) name of the species recorded 
• Common name – the English name for the species 
• Taxon group – group names, such as insect – true fly (Diptera); centipede; terrestrial mammal; bird 
• Site name – the name entered under ‘Location’ either a formal site name or the free text description 

entered 
• Date – the date of  the recording 
• Recorder – the entered name of the recorder of the record 
• Images – a thumbnail of any attached photos 
• Grid ref – the map reference or lat/long of the record 
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Sorting on a column 

Click on the title of the column (Species, Site name, Date etc).  The column will be sorted into ascending order 
of that column, either alphabetically, alphanumerically or numerically, depending on the content/format of 
the data. 

An upward-pointing arrow appears by the column label to identify the sorted column and an ascending sort.  A 
second click reverses the sort-order to descending.  Only one column can be sorted at a time. 

Temporary Filters 

Just below the ID column label is a tiny filter-funnel icon.  This labels a blank row, into which you can type 
search terms.  You can type in a word or part of a word.  If you type ‘formica’ it will bring up only Formica ants.  
However, if you type ‘for’ it will bring up Formica, Forficula and any other species records beginning ‘for’.   

Once you have typed in your search word, use the Tab key to move out of the box, or use the Enter key or use 
the mouse to click outside the box for the filter to take effect. 

If you wish to search for a word that may not be at the start of the name you can use a wildcard ‘*’ symbol.  If 
you now type ‘*for’ you will still get Formica and Forficula, but also Chloromyia formosa, Chrysopilus 
asiliformis and many others. 

These filters can be combined across a number of columns.  For example you may search ‘formica’, but then 
put Brockholes in the Site name filter.  The list of ant records will now only show those from the Brockholes 
site. 

The wildcard filters work on all columns (including Grid ref) except the Site name and Date columns.  The site 
names can only be filtered by the start of the name (no wildcards) and the Date can be filtered by year by 
typing either 2018 or 18 or by a single day, using the dd/mm/yyyy format. 

Sorting from the map 

If you look at the top right-hand corner of the map and click the (?) icon, you can then click on individual 
squares on the map.  The records grid will then show only those records from that square.  You may 
sometimes get a warning box saying that there are too many records to show in the grid.  This is no problem as 
they display over several pages.  You can reduce the number of records by zooming in further and selecting a 
smaller square. 

Sorting and filtering on other Records tabs. 

Similar sorts and filters can be used on columns in the Species, Taxon groups and Families tabs of ‘exploring … 
records’ – to be found just below the map. 
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CHAPTER SEVENTEEN 

WHAT CAN GO WRONG? FAQs 
I made a mistake and now my submitted record is wrong. 
It may be that you clicked the wrong date, the wrong year, got the grid reference wrong or have changed your 
mind about the identification.  None of this is a problem. 

You can only delete or edit your own records.  Go into Explore my records and find the record of interest by 
sorting and/or filtering.  See Chapter 15 on searching and filtering records to find it.  In the unlikely case that 
you know the unique record number, it is easy, but it shouldn’t take long.  If you have just submitted the 
record, then go to the ‘My records’ page and it will be at the top of the list – easy. 

 

  

On the right side are two symbols.  Right click the pencil and paper symbol and choose ‘Open link in a new 
tab’.  This will open the full record in a new tab so that you keep the Explore page where it is and don’t lose 
your original list.  You can now edit the record.  Once you have edited it scroll down and click the Submit 
button.   

If you want to delete it click Delete record button. 

If you send in an erroneous record from your phone app, you will have to edit it online later.  Once it is sent in 
you can’t edit it in the app. 

USEFUL NOTE – If you entered records using ‘Enter a list of records (for a site on a date) and you got anything 
wrong that is common to all the list of records (for example date) you only need to correct any one record and 
it will automatically correct all of the others.  This is great and can save a lot of time.  If you are worried about 
this, then you can click ‘View all records in this sample’ to see all the others. 

My Records aren’t being verified. Also see: https://www.brc.ac.uk/irecord/records-verified 
All verifiers are experts in their field, but are all amateurs with other jobs, roles and responsibilities.  Their 
verification may be limited to certain groups or taxa, or to specific geographical areas – or both. 

Some verify material quickly and regularly; others may do it less frequently as they fit it in around other things.   

Some groups may not have verifiers; other groups may only have verifiers for certain counties or regions 
(https://www.brc.ac.uk/irecord/records-verified). 

iRecord verifiers are appointed in consultation with the national recording schemes, some of which work 
through networks of county recorders.  Some schemes are happy to appoint teams of verifiers, others prefer 
to keep it to their existing pool of experts.  If you are experienced with a particular group of species and would 
like to be involved with verification please contact BRC and they will put you in touch with the relevant 
recording scheme. 

My record was rejected as being ‘out of range’ or for other reasons I don’t 
understand. 
The system has some automated processes to flag records that fall outside known ranges or are unusual in 
some way.  These automated systems are primarily there to help Verifiers, especially when some may be 
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keeping on top of tens of thousands of records per year!  Be patient – this automated response is only a 
holding response and hopefully a Verifier will process it in due course. 

I have had notifications querying my records, what do I do? 
Notifications may be emailed to you with a hyperlink back to your record, from which you wil be able to add 
comments or edit the record – but new ones are also visible at the top left of the Home screen. 

 

Click on the ‘You’ve XX unread notifications’ 

The Notifications screen will open. 

 

The top one was queried as the species is not known in the area.  It was an error.  To correct it – click on the 
first (pencil & paper) icon and edit the species, then Submit. 

If you click the second (magnifying glass) symbol you’ll see the whole record, plus the comments from the 
verifier.  You also have a box where you can add you own comment – in this case an apology for selecting the 
wrong name in the iRecord App. 
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I have tried to enter a species name (or my site name) and after ages it hasn’t 
pulled up any names. 
This seems to happen sometimes, often when the screen has had no activity for a while.  Reloading 
the page will usually ‘free it up’ again. 

I have a box saying ‘Leave site? Changes that you made may not be saved’.   
This box is just a failsafe to make sure you are not about to ditch a load of records you’ve just 
entered into a list and haven’t submitted. 

The species I am recording isn’t in the list 
The most likely reason is that you are using an old name.  Scientific names often change as a result of 
the latest research.  Click on the Filter funnel icon next to the word ‘Species’ at the head of the 
column.  The box below will open.  In the lower box choose ‘All names including common names 
and synonyms’ – then Apply.  Your old name will now work.  However, it may be slower as it is 
checking many more possibilities for each entry.  You can easily change it back afterwards to speed it 
up again. 

Alternatively look up the latest name in a checklist or on the NBN Atlas site and use that.  

If you need to add a species that has recently been added to the British list then you will need to 
contact BRC to get it added (and BRC will then liaise with the UK Species Inventory (UKSI) at the 
Natural History Museum. 
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The iRecord site won’t load at all. 

Maintenance may be taking place.  Usually major upgrades etc that take down the system are 
notified in advance.  The only solution is to revisit later. 

Sometimes the site seems to be very slow.  I suspect that this is when large data files are being 
uploaded or large tasks being processed.  If it is really annoying you – best to try again later (this 
doesn’t happen often).  
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CHAPTER EIGHTEEN 

TOP TIPS & SOME FUN THINGS 
Filters 

Wherever you see the little Filter symbol  you can click in the white area under the heading 
name and type in terms to filter all the records in the table.  Remember that the * symbol is a 
wildcard.   

The best way to learn about this is to try playing with it in different ways.   

To clear a filter – just delete your search word then hit the Enter key. 

Right click – open in new tab 
Get used to opening new pages with a ‘Right Click’ on the mouse rather than a normal mouse-
click.  There is a very good reason for this.  If you run a filter or sort a table of records and then open 
a record to look, then click the ‘Back’ arrow, the screen will have reset to its initial unsorted or 
unfiltered state, so you would have to start all over again.  If you haven’t saved your filter, this can 
be extremely annoying! 

If you get used to always opening a fresh tab (right click) you will avoid this problem. 

 

Forum 
This is where you can read about new announcements, how to do things, or to report issues or ask 
for help.  Alternatively, and to report urgent problems, you can email the iRecord teamvia 
irecord@ceh.ac.uk 

Help 
This is where you can find the online information that is included in this document and quite a bit of 
stuff that isn’t. 

FUN STUFF 

Recorder league (as of April 2019 it is being replaced after a period when it often failed to work) 
Click Explore > Recorder league 

This lists all recorders contributing to iRecord, sorted according to either the number of records they 
have entered or the number of species they have entered records for.  Just a bit of fun really – 
unless you are a ‘pan-species recording’ enthusiast with a competitive streak? 
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CHAPTER NINETEEN 

ACTIVITIES 
The Activities menu gives access to a wide range of activities, ranging from national recording 
schemes to one-off bioblitzes.  A number of recording schemes (such as British Dragonfly Society) 
have their own activities, linked to specially-developed data entry forms tailored for their particular 
group.  In addition, there are many local groups recording a single reserve or area.   

If you are part of a group recording on one reserve, an activity can let everyone join so that you can 
share each other’s records and see what has been found.  This is much easier than having to filter 
and sort records from the main database.  You can also add boundaries and areas that everyone can 
use for recording – this is the only easy way (currently) to share site boundaries with others.  An 
activity has to have at least one Administrator, only they can set up, and subsequently edit, details 
about the Activity.  There are tabs for My activities, all activities, organisations and old, completed 
activities. 
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You can either search for a particular Activity you want to join or create a new one of your own.  For 
a new Activity click the Create new activity button (above) 

You can add or edit the following and the person creating it will be an Administrator by default 
(Administrators only can edit it in future): 

• Activity name 
• Activity description - free text description 
• Activity type – choice of Events & bioblitzes; Local groups; National groups or Recording forms 
• Logo – load your logo if you have one! 
• How users join the activity – Open; on Request or Invite only 
• Activity active from – start and finish date (if applicable) 
• Activity administrators – the founder and any other recorders added as administrators.  Always worth 

having more than one. 
• Records that are of interest – lets you filter species or groups; geographical area or dates to include. 
• How to decide which records to include in activity reports – can restrict reports to only members’ 

records submitted through the Activity entry-forms; all members’ records, or all records from all 
recorders that fit the Activity criteria (useful to see everything recorded from the site(s) or area. 
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IMPORTANT NOTE – If you have created sites under My Sites you can now add these.  (The following 
page has a screen-grab of an Activity with multiple sites in Lancashire).  Click on the Where (grey box 
with globe icon).  Then go to Choose an existing site or location <Please select> and select My 
sites….  In the box to the right of this you can now type in your site names and they will appear and 
can be selected.  As each one is selected, click Add and it will appear with a red X.  When recorders 
join your Activity, they will have immediate access to all your sites.   

• Which records to include in reports – can restrict records to those from members, or include those 
from anyone that fit the Activity criteria (such as a site boundary) 

• Activity pages – These will appear as buttons on the Activity page.  Options include different ways of 
entering records and what sort of data and data analysis various people can see, set to everyone, 
members or administrators.  You probably need to play with these to see which are of most use to 
your Activity.  The list includes a number of obscure and specialised ones in addition to widely-used 
ones!  You can add, edit or delete these buttons at any time.   

• Don’t forget to click Update activity settings button at the bottom to save settings. You will then get a 
screen Send invites to join an activity where you can add emails.   
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If you click the Activity summary button, the following screens among others will be available 
(depending on the site of course). 
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The Manage activity sites button will allow you to add, edit on remove sites from multi-site-based 
activities, as seen on the screen-grab below. 
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There are two ways to benefit from all this as a member of the Activity.  Either you can select the 
Activity at the top of a normal data entry screen – Record Destination.  Click the drop-down and 
select the relevant Activity.  OR you can automatically enter records into the Activity by going to the 
Activity then click the button on the right for Enter a casual record, …list of records or import from a 
spreadsheet. 

Activities undoubtedly offer opportunities for collaborative working, but need careful thought and 
do have some limitations.   

I suspect that this feature will be developed further in future as a more effective site-management 
tool. (I hope so!)  There may also be additions to button options. 



 

 55  -  Steve Garland, iRecord Training – 2019 

CHAPTER TWENTY 

VERIFICATION 
If you become a verifier there are additional screens that you have access to which allow you to 
Verify records, but this guide is not going to cover that.  Verifiers are people who have expertise in 
particular area of identification, and often also are familiar with a particular area of the country.  For 
example, I verify Neuroptera and allied groups for Cheshire, Lancashire and Cumbria.  Verifiers are 
volunteers and do have lives to lead as well!  Do remember this when waiting for them to verify your 
records.  Neuroptera verifiers have hundreds of records to process, but hoverfly and butterfly (and 
other) recorders have tens of thousands to do, so be supportive of them and their vital work.  Some 
verifiers can verify regularly, others may blitz a year of data at one go – be patient. 

IMPORTANT NOTE – not all groups and areas of the UK have verifiers, so some records won’t be 
verified at all at present.  However, the records will sit there and can be verified at a future time as 
soon as a suitable Verifier is available. 

There is a screen grab of a basic Verifier’s page in Chapter 3 (p8). 

Notifications 

If you have notifications, a clickable note will appear on your iRecord Home page (top left) ‘Welcome 
back Steve. You’ve 2 unread notifications’.   Notifications can also be sent to your registered email 
address – you can control this by going to My account – Edit – Email digest notification settings or 
Advanced notification settings (also see page 11, Chapter 4). 

You will get notifications of two sorts – automatically generated ones and from Verifiers.   

Auto checks - The automated ones can cause annoyance if you don’t understand the process.  If you 
record has been flagged as ‘outside its known range’ this probably just means it is a new 10km 
square – a positive thing.  However, it can be useful for the Verifier to see these sometimes as they 
can make spotting real out-of-known-range records easier. The auto-check is just a tool, not a final 
decision. 

Verifier notifications – These are generated by ‘real humans’ and are the important check.  You will 
receive notifications about them.  If records are queried or not accepted, the Verifier may sometimes 
explain why they decided on rejection.  Sometimes they may ask a question before accepting the 
record.  If you have further information, photos or a voucher specimen that could be sent for 
checking, you can tell them.  Verifiers can update ID’s if new information comes to light or if further 
checks can be completed. 

You can open a record to view (using the ‘magnifier’ icon) and see all comments by the verifier.  You 
can also reply or add more information.  You could add another photo and send a note to help the 
Verifier make a decision.  It is sometimes an opportunity to learn, but remember Verifiers may be 
busy people! 
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CHAPTER TWENTY-ONE 

iRECORD MOBILE APP (v4.0.1) 
Open the App.   

The opening screen shows any existing records 
you added to the app. 

Tap the ‘+’ on the top right to add a new 
record. 

Start typing in a species name – choices appear as you type.  At any point you can select the 
appropriate species.  Typing any part of the scientific or English names will pull up a list of choices.  
Playing with this will let you choose the best way for you to work.  For Bellis perennis you can type ‘b 
pere’ and already the list will only be two species; or bellis, or daisy – the last has many choices 
containing the word ‘daisy’ though.  (Note – as of March 2019 – the five letter code you can use on 
the web-based : 2 from genus, three from species names – does not work in the App. 

Then tap your species entry and the full data entry screen opens 

The location will be set automatically, based on your phone’s GPS location 

You can now enter location details by tapping Location – this opens a map showing your current 
location.  If you don’t want the satellite map you can tap the Layers icon (top right) and choose from 
Satellite, Ordnance Survey map or OpenStreetmap. 

 

You can add free text comments, 
abundance details (there is a slider to 
choose a number or a list of choices), 
Stage (adult etc) and Identifiers (if others 
have helped with the identification). 

If you want to add a photo – tap the 
camera logo at the bottom.  You then 
choose between taking a photo or 
adding one you’ve already taken on your 
phone.  
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Alternatively, you can begin with a photo by tapping the camera icon instead of the ‘+’ and following 
the instructions. 

 

SETTINGS 

Select the menu icon at the top left of the opening screen (three 
horizontal lines).  This opens the iRecord App menu.   

• Logout – does what it says 
• Statistics – shows your most frequently-recorded species 
• Settings App – opens the screen below.  This lets you 

o Submit all – sending in all your newly added records to the main 
iRecord site. 

o Remove all saved – lets you delete all the ones you’ve sent from 
your device 

o Training Mode – lets you use the phone App in training mode – 
as you can with the website App 

o You can turn on and off use of Grid References and showing the 
map grid  

o Manage Saved – lets you select, delete or edit your recently-
used locations 

o Grid Square Unit – can be set to monad (1km) or tetrad (2km) 
o Experimental features (not certain what this does, but I keep it 

turned on! 
o Reset – resets all of these settings to default 

• Help – this is the place to look if you need help using the App 

 

If you make an error and want to delete an 
entry, swipe the record to the left – you will 
then see a red waste bin.  Tap this to delete 
the record.  It will warn you if you haven’t 
sent it in. 

IMPORTANT NOTE – This app lets you 
add new records and edit them PRIOR to 
you sending them in.  Once you tap the 
arrow and send the record in to iRecord, 
you can no longer edit nor delete it in 
this app.  You can only edit or delete it 
by accessing iRecord through a web-
browser via Explore – My records – edit 
button – can be performed on any 
suitable device. 
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LISTS 

If you click the middle of the three icons on the upper-left green tab, you are taken to the Lists page.  
At present (April 2019) this only supports plant recording.  It is set up to enter lists of plant species 
for an individual 1km square (monad).  Its use is for mapping projects where species are being 
logged at the 1km square level.  If this is the sort of recording you are doing, and you are only 
recording plants, this may be of use. 

 

Group-specific Apps 

There are currently Apps available for grasshoppers/crickets (Orthoptera) and butterflies.  These 
operate exactly as the general App, but have specific information to help you identify species 
(including audio of grasshopper calls) and pictures.  Both Apps let you deselect areas of the country 
under settings.  This removes species that don’t occur in the region to make recording simpler. 

Both apps also allow more accurate recording of habitat and stage/age than the basic App, but are 
basically the same. 

Again – once the record has been sent in to iRecord, you can only edit it on the website.  

 

 

 

 

 

 

 

 

 

 

 

 

 

There are other iRecord apps available including: 

• iRecord Soil – Centre for Ecology & Hydrology – experimental app aimed at getting farmers to map 
their soils – aiming to map soils nationally and to advance farming practice 
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CHAPTER TWENTY-TWO 

DOWNLOADING DATA & REPORTS 
You can only download your own records.  However, you can download your full data set if you 
want.  You may want to do this occasionally to keep your own backup of your data.   

Click Explore – Download 

You then see the following screen. 

 

Download type has a dropdown offering ‘My records for reporting’ and options relating to any 
Activities that you have set up or joined.  For each of these you can choose between ‘My records 
added using a recording form for an Activity’.   

If you are an Administrator for the Activity, you can download all records entered by all Activity 
members who used the recording form for the Activity.   

Filter to apply – you can choose ‘all available records’ to get everything or use one of your filters 
that you created earlier on Explore pages. 

Survey to include – Leave this as <All> unless you want to restrict the records to one survey – an 
example is ‘iRecord > Earthworm Survey’.  The advantage of using this is that a download for a 
particular activity may include columns of data not available in a normal list of records.  If you want 
custom attributes, you must use download using specific surveys 
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Date field – this allows you to choose which date field to filter by.  Choices are: 

1. Field record date – the date the record was made 
2. Input date – the date you entered the record onto iRecord and saved it 
3. Last changed date – the date you last altered and saved any changes to the record 
4. Verification status change date 

Field record date The first will let you sort all records made in a particular period – for 
example all those made in 2018 

Input date will let you sort all records that you entered in a particular period.  This would 
enable you to send an updated list for a year of recording if you’ve added a few more 
records from your notebook for the same period. 

Last changed date is useful if you’ve already sent your records to someone for the previous 
year, but know that you’ve corrected a couple of identifications since. 

Verification status change date will let you find any changes made since a particular date.  
This may be of use on occasion. 

Start Date & End Date – These let you choose your period of interest.  Click on the box and you get 
the usual iRecord calendar to click on. 

Select a format to download – gives you the choice on 
the right. 

CSV and TSV are files used to transfer data 
between spreadsheets and databases.  CSV 
files are used as a standard way to import into 
spreadsheets such as Excel, LibreOffice Calc or 
Google Sheets.  You can sort and reformat 
them in a spreadsheet and then import them 
into other recording packages, such as MapMate and Recorder.   

Google Earth (KML) will download a file that can then be imported into Google Earth.  In 
Google Earth click File – Import – find and select your file.  All the records will then appear 
under - Temporary Places – Records.  Each will have a coloured square, a pin and a label 
(species name).  If you click on the species name either in the menu list or on the map – the 
full record will open in a window.  An example of a Google Earth import can be seen on the 
next page – the map can get quite busy, but I can see potential in reviewing for example 
where you’ve recorded froghoppers in the last 5 years?  It is quite fun and interactive. 

GPS track (GPX) – are files that can be imported into GPS software.  If you use a GPS App on 
your tablet or phone it would let you carry data around with you, which might be of value 
when in the field.   

NBN Exchange – is an out-of-date format to allow records to be imported into the National 
Biodiversity Network.  This was for advanced users with access to the NBN, such as those 
running National Recording Schemes. It will be removed in the near future. 
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Other download options 

From the ‘Explore my records’ page you can apply a filter and/or sort the records.  In the bottom 
right-hand corner of the list it says ‘Showing records 1 to 20 of xx’ then ‘Download this report’.  If 
you click this it will download a CSV file with the default name of download.csv.  You can rename this 
and save it wherever you want.  It has a standard format (as below) in Species alphabetical order, 
but does not contain all of the data for each record – only the main elements.  As such it is of limited 
use when trying to export to other databases.  However, if you want a quick list of records filtered in 
some way it is perfect. 

 

You can also produce reports from the My sites screen. 

Choose a site and click the explore button next to it under Actions.  You will then see a list of all the 
records for the site.  In the bottom right corner, it tells you haw many records there are and gives an 
option to download this report.  Click this and you get another CSV file – format as above. 
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CHAPTER TWENTY-THREE 

IMPORTING DATA FROM A SPREADSHEET 
Importing records to iRecord from a spreadsheet  

Version 3.2 compiled by Martin Harvey at 12 February 2018  
  
If you have wildlife records in a spreadsheet it is possible to import them all in one go to iRecord if 
you wish to do so, as an alternative to entering them directly onto the iRecord website or app.   
  

 IMPORTANT NOTE – READ BEFORE YOU IMPORT SPREADSHEET DATA.:   
If you need to import large amounts of data (10,000 records or more) please contact iRecord first – 
large imports need to be scheduled so as not to disrupt iRecord for general use.  
  
If you are dealing with new records that have not been sent in to recording schemes it’s fine to 
import them. If your spreadsheet contains records that have been sent in to schemes before then 
we would prefer you not to import them, as the recording scheme verifiers will have to spend time 
checking them again and duplications may result. If in doubt, please check with the relevant scheme 
organisers first, or contact irecord@ceh.ac.uk  
  

  

1. Your spreadsheet  
Your spreadsheet needs to have a single row per record, with the first row for the headings to give 
each column a label. The minimum requirement is to have at least five or six columns to show the 
species name; the location name; the grid reference; the date; the ‘recorder (name of the person 
who made the record); and the  
‘determiner’ (name of the person who identified the species, if that was someone different from the 
recorder).  
  
You can add extra columns as well. For example, it is often useful to know how many of each species 
was seen, and for some species groups it is important to note whether it was an adult, juvenile or 
other life stage that was seen. It doesn't matter what words you use for your column headings, as 
long as you are clear what each column means – you can match your column headings to iRecord’s 
equivalent during the import (see step 4 below).   
  
A typical spreadsheet set-up:  
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Make sure that the first row of your spreadsheet contains the column headings – don’t put a title or 
any other information above the headings row. Before you can upload your spreadsheet to iRecord, 
you have to ‘save as’ a comma-separated-values text file (CSV file) – it is the CSV file that can be 
imported to iRecord.  
  
Some of the columns will only import if their contents match what iRecord is expecting. For instance, 
the species names can be scientific or English names, but they have to match the names that iRecord 
uses, which are taken from the UK Species Inventory, see: www.nhm.ac.uk/our-science/data/uk-
species.html   
  
Some of the other columns such as Stage and Sex also have to match a predefined set of terms – see 
the termlists at the end of this document.  
    
2. Doing a test import  
The import process can be complex, and once you commit to importing your records (at the end of 
step 4 below) there is no turning back! If you wish, you can do a test import before doing it for real. 
To do a test you need to put your iRecord account into “training mode” (see 
www.brc.ac.uk/irecord/training-mode for how to do this).  
  
Once you have set your account to Training mode, any records that you import will only be saved as 
training records, and will not be visible to others. Once you are happy with how the import process 
works you can take your iRecord account out of training mode and do the import again for real.  
  
3. Importing into iRecord  
Log on to iRecord1 and go to this link: http://www.brc.ac.uk/irecord/import-records  
There is some information on that page about the import process. It suggests that you should 
download a template file and use that for your records, but there is no need to do this. As long as 
your spreadsheet records are organised into a format similar to that shown above you should be 
able to import them.  
  

If you do want to use the iRecord template click on:   
  

Alternatively, click   to import an existing CSV file and then match your column headings to  
those that iRecord recognises. On the next page, click on “Choose file” and tell iRecord where your 
CSV file is saved on your computer, and then click on “Upload” to start the import process:  

                                                           
1 See Appendix 4 for more about options for logging on before you import records  
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http://www.nhm.ac.uk/our-science/data/uk-species.html
http://www.brc.ac.uk/irecord/training-mode
http://www.brc.ac.uk/irecord/training-mode
http://www.brc.ac.uk/irecord/training-mode
http://www.brc.ac.uk/irecord/training-mode
http://www.brc.ac.uk/irecord/import-records
http://www.brc.ac.uk/irecord/import-records
http://www.brc.ac.uk/irecord/import-records
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http://www.brc.ac.uk/irecord/import-records
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On the next page you need to specify which “Survey” you want to import your records into, by 
selecting from the dropdown list. In most cases you should choose “iRecord Import” unless you have 
a specific need to use a different Survey. (For example, some recording schemes have a custom 
recording format set up in iRecord any may prefer to import records into that format – if in doubt 
about which Survey to use contact irecord@ceh.ac.uk).   
  
Also on this page you need to choose the “Species list” that you will be using – for standard records 
you should always use “UK Master List”:  
  

 
Once you have filled in the two boxes, click Next and you will come to a screen where you can match 
the column headings in your CSV file to the fields in iRecord.   
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4. Matching your columns to iRecord’s attributes  
The column headings from your CSV file are shown on the left of this page, and you have to tell 
iRecord how to match your headings to the choices from the dropdown lists under “Maps to 
attribute”.  
  

 
  
    
Click on the down arrow next to each field to ensure they are matched correctly. There are a lot of 
iRecord attributes to choose from, and it can be difficult to know which attribute to choose – if in 
doubt please contact irecord@ceh.ac.uk for advice. Here are the most frequently used options, and 
note that many of the possible attributes can be ignored (if you think you need to use one of these 
grey “Ignore” attributes please contact us) – be particularly careful to choose the correct matches 
for the recorder and determiner names:  
  
Type of data from import   iRecord attributes  
   Occurrence  
Ignore   Use determinations table for identification 

information (Y/N)  
Any comment for an individual record (compare with “Comment” under 
“Sample” below)  

 Comment [= Occurrence Comment]  

Ignore   Confidential  
Ignore   Downloaded flag  
Ignore   Downloaded on  
If you are importing records from another system that gives each 
record unique ID, you can import that ID here  

a  External key  

Ignore   Created by (from controlled termlist)  
Ignore   Determiner (from controlled termlist)  
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The species name – can be scientific or English but must match the UK 
names that iRecord uses  

SI  Species or taxon name  

If you use Taxon Version Keys you can import them instead of the 
spec name – otherwise ignore  

ies  Species or taxon external key (from controlled 
termlist)  

Ignore   Species or taxon search code (from controlled 
termlist)  

Ignore   Updated by (from controlled termlist)  
Ignore   Verified by (from controlled termlist)  
Ignore   Last verification check date  
Ignore   Record decision source  
Ignore   Record substatus  
Ignore   Release status  
Ignore   Sensitivity precision  
Ignore   Training  
Ignore   Verified on  
Ignore   Zero abundance  
   Occurrence media  
Ignore   Media Caption 1  
Ignore   Media Caption 2  
Ignore   Media Caption 3  
Ignore   Media Caption 4  
Ignore   Media Path 1  
Ignore   Media Path 2  
Ignore   Media Path 3  
Ignore   Media Path 4  
   Occurrence custom attributes  
Can import if needed – has to match predefined terms, see Appendix 1 
termlists below  

 Certainty (from controlled termlist)  

Ignore   Determination reference  
Ignore   Determination year  
Ignore [use “Identified by” instead]   Determiner  
Ignore   Identification type (from controlled termlist)  

 This is for the determiner, the person who identified the species (do 
not  

  Identified 
By 

  

use the “Determiner” attribute!)   
For method terms that apply to individual records (compare with 
“Sampl method” and “Method (free text)” below) – has to match 
predefined term see Appendix 1 termlists below  

e  
s,  

Observation Type (extensive) (from controlled 
termlist)  

Can be a number or text   Quantity  
Has to match predefined terms, see Appendix 1 termlists below   Sex (from controlled termlist)  
Has to match predefined terms, see Appendix 1 termlists below   Stage (extensive) (from controlled termlist)  

    
Type of data from import  iRecord attributes  
  Sample  
Any comment that applies to a whole sample or set of records (needs to 
be supplied for each imported record) (compare with “Comment” under 
“Occurrence” above)  

Comment [= Sample Comment]  

In format dd/mm/yyyy  Date  
An alternative to supplying the standard “Date”  Day (Builds date)  

Month (Builds date)  
Year (Builds date)  
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An alternative to supplying the standard “Date”, and can be used for date 
ranges, but the correct “Date type” code must be supplied, see Appendix 2 
below  

Date end  
Date start  
Date type  

An Ordnance Survey grid reference (please contact us if you need to use 
lat/long or another system)  

Grid ref or other spatial ref  

If you are importing records from another system that gives each sample (set 
of records) a unique ID, you can import that ID here  

External key  

Ignore  Created by (from controlled termlist)  
Ignore  Group (from controlled termlist)  
Ignore  Licence (from controlled termlist)  
Ignore  Location (from controlled termlist)  
Ignore  Location Code (from controlled termlist)  
If you are importing records from another system that gives each location a 
unique ID, you can import that ID here  

Location external key (from controlled termlist)  

Ignore  Parent (from controlled termlist)  
Ignore  Parent sample external key (from controlled 

termlist)  
For method terms that apply to samples/sets of records (compare with  
“Observation type” above and “Method (free text) below) – has to match 
predefined terms, see Appendix 1 termlists below  

Sample method (from controlled termlist)  

A free text field for method terms (does not have to match a predefined list) – 
compare with “Observation type” and “Sample method”, above  

Method (free text)  

Ignore  Updated by (from controlled termlist)  
Ignore  Verified by (from controlled termlist)  
Ignore  Input form  
Site name or location name, preferably a recognised name e.g. from an OS 
map, but any text can be imported  

Location name  

Ignore  Privacy precision  
Ignore  Record status  
Ignore [use “Recorder Name” instead]  Recorder names  
Ignore  Verified on  
  Sample custom attributes  
Habitat – has to match a predefined list such as EUNIS (this is complex, 
please contact us if you need to use this)  

EUNIS Habitat  

A free text field for habitat  Habitat  
 This is for the recorder, the name of the person who made the record 
(do  

  Recorder 
Name 

  

not use the “Recorder Names” attribute!)   
iRecord automatically calculates the vice-county (VC) for each imported grid 
reference, so you don’t have to import the VC, but you can do so if you wish. 
You must have the VC numbers (not names) in your spreadsheet – see 
http://www.brc.ac.uk/article/british-vice-counties   

Vice County (supplied)  

  
Once you have matched all your column headings to iRecord attributes, click on Upload and the 
loading will start. You will see a progress bar. If any records fail to import you will be able to 
download a CSV file giving the reason for failure. Typically this will be due to species names not 
matching names in the UK Species Inventory, or habitats not matching names in the classification 
systems used in iRecord, for example. If possible, you should edit and correct this downloaded set of 
failed records and then re-import them (but only re-import the failed records, don’t import the 
whole dataset again).   
  
If you have any questions or encounter any difficulties, please contact us on irecord@ceh.ac.uk  

http://www.brc.ac.uk/article/british-vice-counties
http://www.brc.ac.uk/article/british-vice-counties
http://www.brc.ac.uk/article/british-vice-counties
http://www.brc.ac.uk/article/british-vice-counties
http://www.brc.ac.uk/article/british-vice-counties
http://www.brc.ac.uk/article/british-vice-counties
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Appendix 1: iRecord termlists  
  
As shown in section 4, for some attributes there are termlists used in iRecord, and if you want to 
import your data into these attributes you have to make sure that the terms in your spreadsheet 
exactly match the terms available in iRecord, as shown below. (If you have a need to import a term 
that isn’t in these lists please contact irecord@ceh.ac.uk – we can’t always add new terms but we 
are happy to consider doing so.)  

  
Certainty  Sample method  
    
  

Observation type  
  
  

  
    

Sex  Stage  
    

Term  
Certain  
Likely  
Uncertain  

Term  
Unknown  
Field Observation  
Quadrat  
Transect  
Net  
Pitfall Trap  
Light Trap  
Transect Section  
Parent sample  
Child sample  
Timed Count  
Timed Count Count  
TreeInitialRegistration  
TreeVisit  
Garden Bird Survey count  
Visit  
Seasearch buddy pair  
Seasearch habitat  
Grid square  
Light  
Actinic Light  
Daytime observation  
Dusking  
Attracted to a lighted window  
Sugaring  
Wine Roping  
Beating tray  
Pheromone trap  
Other method (add comment)  

Term  
Actinic moth trap  
Call  
Field sighting  
Field identification  
Field sign  
Fungal gall  
Insect gall  
Leaf mine  
light trap  
Other gall  
Robinson moth trap  
Other  
Caught  
Collected  
Field record  
Flying  
Nest  
dung/droppings/frass/pellet, etc.  
voucher specimen, trapped (other)  
voucher specimen  
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Term  
not recorded  
male  
female  
mixed  

 

 
Term  
Adult  
Teneral  
Pupa  
Larva  
Immature  
Nymph  
Larval web  
Larval case  
Leaf-mine  
Egg  
Other  
Exuvia  
Flowering  
Fruiting  
Gall  
Not recorded  
Spawn  
Vegetative  
Juvenile  
Tadpole  
Nest  
Mature  
Seedling  
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Appendix 2: Importing date ranges into iRecord via a CSV upload  
  

A. Sets of records that don’t contain date ranges  
If all your records are from individual days, and you haven’t used any date ranges, then you can just 
use the date column in your CSV file and import that column into iRecord’s “Date” field.   
  

B. Sets of records that do contain date ranges  
If any of the records in your spreadsheet are linked to a date range (e.g. if they were entered just as 
a year rather than an individual date, or used a range from one day to another), the data set will 
need to be treated differently. You will need a column for the start of the date range (which you will 
import into iRecord’s “Date start” attribute), and another for the end of the date range (which you 
will import into iRecord’s “Date end” attribute). In addition, you will need to add a “Date type” 
column.  
  
Any single-day records need to have “D” in the Date type column, but any date ranges will need to 
be coded by you, using the following “DateType” codes:  
  
DateType  Description  Examples:   

StartDate  EndDate  
D  Date specified to the nearest day.  16/06/2016  16/06/2016  
DD  Date specified to a number of days.   16/06/2016  18/06/2016  
O  [This is a capital “O”, not a zero] Date specified to the nearest month (first 

day of the month to the last day of the month)  
01/06/2016  30/06/2016  

OO  [These are capital “O”s, not zeros] Date specified to a range of months  
(first day of the start month to the last day of the end month)  

01/06/2016  31/07/2016  

Y  Date specified to the nearest year (first day of the year to the last day of 
the year)  

01/01/2016  31/12/2016  

YY  Date specified to a range of years.  01/01/2012  31/12/2015  
  
Once you have the data arranged correctly in your CSV file, you can upload it us usual, taking care to 
match the date fields when you get to the “field mapping” part of the import:  
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Appendix 3: Spreadsheet template for importing records to iRecord  
  
This is the format of the spreadsheet template that you can download from 
http://www.brc.ac.uk/irecord/import-records  
  
As explained above, there is no need to use this template unless you wish to, iRecord is very flexible 
in the formats that can be used.  
  
Columns with an asterisk are mandatory.  
  

Species name*  Recorder 
name*  

Certainty  Identified 
by  

Quantity  Site  
name  

Grid 
ref*  

Date*  Habitat  Sample 
comment  

  
Must match a  
scientific or 
vernacular species 
name in the UK 
Species Inventory  

  
Ideally as  
“Surname, 
First-name”, 
but any text 
is accepted  

  
Certain, Likely 
or Uncertain  

  
  

  
Can be a 
number or 
can be text  

      
dd/mm/yyyy  
(or a 'vague 
date' e.g. 
June 2013)  

  
Must match a field 
from an existing 
iRecord survey  
e.g. Phase 1, Eunis, 
JNCC Biotopes  

  
  

  

                    

                    

                    

                    
  
  

  

http://www.brc.ac.uk/irecord/import-records
http://www.brc.ac.uk/irecord/import-records
http://www.brc.ac.uk/irecord/import-records
http://www.brc.ac.uk/irecord/import-records
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Appendix 4: Imports and iRecord accounts  
  
When you import records into iRecord, the records will be allocated to the iRecord account that is 
signed in at the time of import. In other words, if you log on to iRecord and import some records, 
those records will be ‘owned’ by your account.  
  
If your spreadsheet contains records from recorders other than yourself those records will be 
imported, and the recorder name will show as the name you imported, but the record will still be 
linked to your account and will be counted as ‘yours’ for the purposes of calculating the total 
number of species you have seen in the iRecord league tables, and for display under “My Records”.  
  
If you regularly import records that originate from recorders other than yourself, you may wish to 
set up a second iRecord account that you use for import purposes. This will still make the records 
available within iRecord, but they will be kept separate from your own personal records. This may be 
particularly relevant if you are a recording scheme organiser who needs to import records sent in as 
spreadsheets by recorders who do not use iRecord themselves.  
  
You can set up a second iRecord account with any user name as along as it has its own email address 
– you cannot register the same email address twice.  
  
Please ensure you have permission to import records from other recorders, and make sure you are 
not duplicating records that they may add to iRecord themselves.  
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A quick note on other online recording and analysis systems. 

iSpot – this is primarily an identification site where users can post photographs for identification.   

iNaturalist – This is an international biological recording site.  Judging by the maps, it is particularly 
popular in the USA.  It offers about the only easy option if you wish to record observations outside 
the UK from travels or holidays.  It has a record verification framework consisting of ‘Casual’, 
‘Needing ID’ or Research Grade and is in many ways similar to iRecord in its aims.  At present there is 
no sharing of data between iNaturalist and iRecord, so you are probably best sticking with one or the 
other.   I prefer iRecord as it is currently the best way to feed data into the National Biodiversity 
Network (NBN) and National Recording Schemes.  However, at some point in the future it is essential 
that the two work together, I think.  However, challenges include a different Verification system and 
different species dictionaries so it won’t be easy! 

(Note as of April 2019 – provision is being made for transfer of “research grade” data (see iNaturalist 
site for explanation of their verification system) being entered into iRecord as part of the City Nature 
Challenge project 2019 to allow records from that project to be captured.  However, there is no 2-
way linking, so any records subsequently changed as a result of verification can not be reimported to 
iNaturalist!) 

Pantheon – Not an online recording system, but an analysis system for lists of invertebrates.  You 
can upload species lists and get reports from them, based on scarcity, habitat preferences and other 
criteria.  It is being added to and improved all the time.  Lists of species are all very well, but this 
software will help to evaluate them. I use it as a quick way to add value to species lists I send to 
site/conservation managers. 

IF YOU HAVE ANY FEEDBACK OR COMMENTS ON THIS DOCUMENT, 
PLEASE EMAIL ME AND I WILL UPDATE IT FOR FUTURE USERS. 

Steve Garland FRES – steve@stevegarland.co.uk 
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